
Ciljevi učenja

•	 Radite s jednačinama.
•	 Dodajte globalne promenljive.
•	 Potiskujte i otkrivajte tipske oblike.
•	 Dodajte jednačine.
•	 Radite s konfiguracijama.
•	 Pravite konfiguracije pomoću projektnih tabela.
•	 Menjajte stanje potisnutosti komponenata pomoću projektne tabele.
•	 Menjajte vidljivost komponenata pomoću projektne tabele.
•	 Menjajte i brišite projektne tabele.
•	 Pravite tipske oblike za biblioteku.

Poglavlje 19

Jednačine, 
konfiguracije 
i tipski oblici 
iz biblioteke
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U ovom poglavlju upoznaćete neke naprednije alatke koje se koriste za poveća-
nje produktivnosti u režimima Part, Drawing i Assembly. Tim alatkama ćete praviti 
jednačine pri modelovanju delova, konfiguracije i tipske oblike za biblioteke. Alat-
ke i postupci za izradu jednačina i konfiguracija opisani su u nastavku.

Rad s jednačinama
Glavni meni:
Paleta alatki:

Tools > Equations
Tools > Equations

Jednačine (engl. equations) matematičke su relacije između mera skice ili tip-
skog oblika. U jednačini, imena mera se koriste kao promenljive. Da biste u 

okruženju za skiciranje ili u okruženju za modelovanje delova dodali jednačine, 
pritisnite dugme Equations na paleti alatki Tools; otvoriće se okvir za dijalog Equ-
ations, Global Variables, and Dimensions (slika 19-1).

Opcije iz tog okvira za dijalog koriste se za dodavanje jednačina, potiskivanje 
i otkrivanje tipskih oblika i primenu globalnih promenljivih, a njihov opis sledi.

Slika 19-1  Okvir za dijalog Equations, Global Variables i Dimensions

Equation View
Ako je u okviru za dijalog Equations, Global Variables, and Dimensions iza-
brano dugme Equation View, u njemu će se prikazati sve globalne promenlji-

ve, jednačine za tipske oblike i mere primenjene na aktivan deo.

Sketch Equation View
Ako je u okviru za dijalog Equations, Global Variables, and Dimensions iza-
brano dugme Sketch Equation View, u njemu će se prikazati sve globalne pro-

menljive, jednačine za tipske oblike i mere primenjene na aktivnu skicu. Pored 
toga, ovo dugme vam omogućava da dodajete, brišete ili menjate jednačine skice.

Dimension View
Ako je izabrano dugme Dimension View, u okviru za dijalog će se prikazati 
sve globalne promenljive, jednačine za tipske oblike i mere dela. Imajte u 

vidu sledeće: kada izaberete ovo dugme, prikazaće se sve mere aktivnog dela, čak i 
ako na njega nisu primenjene jednačine.



Poglavlje 19: Jednačine, konfiguracije i tipski oblici iz biblioteke	 3

Ordered View
Ako je izabrano dugme Ordered View, prikazaće se sve jednačine i globalne 
promenljive po redosledu kojim se rešavaju zato što je podrazumevano potvr-

đena opcija Automatic solve order. Da biste promenili redosled, morate isključiti 
tu opciju. Više o promeni redosleda jednačina i globalnih promenljivih saznaćete 
kasnije u ovom poglavlju. Uz to, ako je neka jednačina aktivnog dela potisnuta, pri-
kazaće se u okviru za dijalog tako da je možete vratiti. Da biste to uradili, desnim 
tasterom miša pritisnite potisnutu jednačinu; prikazaće se priručni meni iz kojeg 
treba da izaberete opciju Unsuppress.

Rebuild
Dugme Rebuild se koristi za osvežavanje ili ažuriranje skica, modela ili sklopova 
nakon menjanja jednačina. Ako ste izmenili jednačine u okviru za dijalog Equati-
ons, Global Variables, and Dimensions, primetićete da se izmene neće primeniti 
automatski. Da biste sproveli izmene, izaberite dugme Rebuild. Možete ga izabra-
ti u svakom trenutku da biste ažurirali jednačine i ponovo generisali skice, mode-
le, sklopove i crteže u skladu sa izmenjenim jednačinama.

Automatically rebuild
Opcija Automatically rebuild podrazumevano je izabrana, tako da se model auto-
matski ponovo iscrtava kada ga izmenite.

Angular equation units
Opcije u padajućoj listi Angular equation units koriste se za promenu ugaonih jedi-
nica u radijane ili stepene. Podrazumevano je izabrana opcija Degrees.

Automatic solve order
Ova opcija je podrazumevano izabrana, pa SOLIDWORKS automatski identifiku-
je zavisnosti jednačina. Pošto jednačine u koloni Value / Equation zavise od neza-
visnih jednačina u koloni Name, jednačine u koloni Name rešavaju se automatski 
pre jednačina u koloni Value / Equation. Prema tome, globalne promenljive, jed-
načine za mere i tipske oblike dodate delu ili sklopu automatski se ređaju u odre-
đen redosled da bi bile rešene. Da biste promenili podrazumevani redosled jed-
načina, morate isključiti opciju Automatic solve order. Kada to uradite, možete 
izabrati red jednačina koje ćete preurediti i povući ga na odgovarajuće mesto.

Filter All Fields
Polje Filter All Fields koristi se za traženje potrebnih jednačina, mera, tipskih oblika 
i globalnih promenljivih u okviru za dijalog. Da biste pronašli određeni objekat, une-
site njegovo ime u ovo polje; pronađeni objekat će se prikazati u okviru za dijalog.

Configuration
Padajuća lista Configuration prikazuje se samo kada obrađujete deo s više konfigu-
racija i koristi se za prikazivanje svih konfiguracija. Iz ove liste možete izabrati kon-
figuraciju i na njene mere primeniti jednačine i globalne promenljive.
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Link to external file
Opcija Link to external file služi za formiranje veze između spoljne tekstualne da-
toteke s jednačinama i globalnim promenljivama i aktivnog dela. Uz to, pomoću 
ove opcije možete i izvesti jednačine i globalne promenljive aktivnog dela u tek-
stualnu datoteku.

Dodavanje globalnih promenljivih
U programu SOLIDWORKS možete dodati globalne promenljive pomoću okvira 
za dijalog Equations, Global Variables, and Dimensions. Da biste to uradili, otvori-
te okvir za dijalog i izaberite dugme Equation View, ukoliko već nije izabrano. Za-
tim pritisnite praznu ćeliju čvora Global Variables u koloni Name i zadajte ime glo-
balne promenljive, prema slici 19-2. Nakon toga pritisnite ćeliju koja odgovara toj 
ćeliji u koloni Value / Equation; prikazaće se priručni meni. Uz to, prikazaće se – u 
navodnicima – i ime zadato za globalnu promenljivu u prethodnoj ćeliji.

Slika 19-2  Globalna promenljiva dodata u okvir za dijalog Equations, Global Variables, 
and Dimensions

Sada možete zadati vrednost za globalnu promenljivu pomoću opcija iz priruč-
nog menija ili unošenjem vrednosti direktno u odgovarajuće polje. Kao vrednost 
globalne promenljive možete odabrati i meru iz oblasti za crtanje. Možete obavljati 
različite matematičke operacije koristeći simbole plus (+), minus (-) itd., i zadajući 
vrednosti za jednačinu i globalnu promenljivu u odgovarajućoj ćeliji. Uz to, doda-
toj globalnoj promenljivoj možete pridružiti i komentar, u njoj odgovarajućoj ćeli-
ji u koloni Comments.

Nakon dodavanja globalne promenljive, možete je koristiti za međusobno po-
vezivanje svih jednačina koje se odnose na određenu komponentu. Razmotrite 
deo čija je skica prikazana na slici 19-3. Otvorite okvir za dijalog Equations, Global 
Variables, and Dimensions i dodajte globalnu promenljivu po imenu length, pre-
ma ranije opisanom postupku i slici 19-4. Zatim pritisnite odgovarajuću praznu će-
liju u koloni Value / Equation i zadajte 200 kao vrednost globalne promenljive. Na-
kon toga, u odgovarajuću ćeliju u koloni Comments unesite komentar za dodatu 
globalnu promenljivu (slika 19-4).
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Slika 19-3  Skica dela

U okviru za dijalog dodajte još jednu globalnu promenljivu – pod imenom 
width – i pritisnite odgovarajuću praznu ćeliju u koloni Value / Equation; prika-
zaće se priručni meni. U njemu izaberite Global Variable > length(200); globalna 
promenljiva length biće istaknuta u koloni Value / Equation, a prikazaće se i zele-
ni znak za potvrdu. Pritisnite taster minus (-) i u tu ćeliju unesite vrednost 50. Za-
tim izaberite taj znak za potvrdu; globalna promenljiva width biće dodata u okvir 
za dijalog. Toj promenljivoj možete dodati i komentar, u odgovarajuću ćeliju u ko-
loni Comments (slika 19-4).

Slika 19-4  Globalne promenljive dodate u okvir za dijalog Equations, Global Variables, 
and Dimensions

Nakon dodavanja globalnih promenljivih, morate dodati jednačine da biste ih 
međusobno povezali, a koristeći dodate globalne promenljive. Da biste to uradili, 
pritisnite praznu ćeliju pod čvorom Equations u koloni Name i izaberite meru s vred-
nošću 200 u oblasti za crtanje; njeno ime će se prikazati u izabranoj ćeliji. Pored toga, 
u odgovarajućoj ćeliji iz kolone Value / Equation prikazaće se priručni meni. U nje-
mu izaberite stavku Global Variable > length(200); globalna promenljiva length biće 
istaknuta u koloni Value / Equation, a prikazaće se i zeleni znak za potvrdu. Izaberi-
te taj znak za potvrdu; u okvir za dijalog biće dodata ta jednačina (slika 19-4).
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Da biste dodali drugu jednačinu, pritisnite praznu ćeliju pod čvorom Equations 
u koloni Name i u oblasti za crtanje izaberite meru s vrednošću 40; njeno ime će se 
prikazati u izabranoj ćeliji. U odgovarajućoj ćeliji iz kolone Value / Equation prika-
zaće se priručni meni. U njemu izaberite stavku Global Variable > length(200); glo-
balna promenljiva length biće istaknuta u koloni Value / Equation, a prikazaće se i 
zeleni znak za potvrdu. Pritisnite taster kosa crta ( / ) i unesite vrednost 5 u tu ćeli-
ju, prema slici 19-4. Zatim pritisnite znak za potvrdu; u okvir za dijalog biće dodata 
ta jednačina. Slično tome, dodajte jednačine drugim merama na skici, prateći sli-
ku 19-4. Imajte na umu sledeće: nakon što skici dodate sve jednačine, ako u kolo-
ni Value / Equation promenite vrednost globalne promenljive length iz 200 u 100, 
sve mere će se proporcionalno promeniti.

Jednačine mogu biti u različitim mernim jedinicama – na primer, inčima, centi-
metrima, milimetrima – a jedinice se mogu koristiti i zajedno. Promenljivu za du-
žinu u jednačinama možete napraviti i dodavanjem veza ka različitim vrednostima 
mera iz različitih sistema mernih jedinica. SOLIDWORKS će automatski razrešiti 
relacije između mera i prikazati konačnu vrednost mere.

Potiskivanje i vraćanje potisnutih tipskih oblika
Tipske oblike određenog dela ili sklopa možete potisnuti ili vratiti. Da biste to ura-
dili, otvorite okvir za dijalog Equations, Global Variables, and Dimensions i priti-
snite praznu ćeliju pod čvorom Features u koloni Name. Zatim s panoa FeatureMa-
nager Design Tree izaberite tipski oblik koji ćete potisnuti/vratiti; u izabranoj ćeliji 
prikazaće se ime tog tipskog oblika. Ispod kolone Value / Equation prikazaće se 
priručni meni. U njemu izaberite opciju Global Variable > suppress / unsuppress; 
u odgovarajućoj ćeliji, pored primenjene opcije biće zeleni znak za potvrdu. Priti-
snite taj znak; izabrani tipski oblik biće potisnut/vraćen (slika 19-5). Alternativno, 
možete koristiti numeričku vrednost 0 ili 1 kako biste vratili odnosno potisnuli tip-
ski oblik. Da biste to uradili, unesite vrednost u odgovarajuću ćeliju kolone Value 
/ Equation. Možete promeniti i postojeću opciju: pritisnite odgovarajuću ćeliju i 
obrišite primenjenu opciju, pa primenite željenu opciju.

Slika 19-5  Potiskivanje i vraćanje tipskih oblika u okviru za dijalog Equations, Global 
Variables, and Dimensions
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Dodavanje jednačina
Jednačine možete dodati i skici ili tipskom obliku. Da biste to uradili, nacrtajte skicu 
i kotirajte je. Zatim izaberite Tools > Equations iz glavnog menija; prikazaće se okvir 
za dijalog Equations, Global Variables, and Dimensions. Ako jednačine dodajete u 
režimu Part, morate pokazati kote tipskih oblika tog dela. Da biste ih pokazali u obla-
sti za crtanje, otvorite priručni meni tako što ćete desnim tasterom miša pritisnuti 
čvor Annotation na panou FeatureManager Design Tree i izabrati opciju Show Fea-
ture Dimensions. Nakon toga izaberite kotu u oblasti za crtanje. Ta kota se naziva vo-
đena ili izvedena kota (engl. driven dimension) i mora se izjednačiti s drugim kotama. 
Druga kota se naziva upravljačka kota (engl. driving dimension). Ako izmenite upra
vljačku kotu, izvedena kota će se takođe izmeniti. Da biste izabrali jednačinu kao 
izvedenu, pritisnite praznu ćeliju pod čvorom Equations u koloni Name i odaberite 
bilo koju kotu u oblasti za crtanje; njeno ime će se prikazati kao promenljiva u odgo-
varajućoj ćeliji u okviru za dijalog. Zatim u oblasti za crtanje izaberite upravljačku 
kotu; njeno ime će se prikazati u koloni Value / Equation, zajedno sa zelenim zna-
kom za potvrdu. Dodajte potrebne matematičke relacije i izaberite znak za potvrdu; 
biće dodata ta jednačina. Osim toga, rešenje jednačine prikazaće se u koloni Evalu-
ates to okvira za dijalog. Svim jednačinama možete dodati imena, komentare i slično 
u koloni Comments. Pritisnite dugme OK da biste izašli iz okvira za dijalog. Možda 
ćete morati i ponovo da izgradite model nakon što dodate jednačine ukoliko opcija 
Automatically rebuild nije podrazumevano izabrana.

Slika 19-6  Skica pravougaonika  
s kotama

Ako želite da nacrtate pravougaonik (slika 19-6) čija se širina automatski sma-
njuje na pola njegove dužine kada izme-
nite dužinu, morate primeniti jednačine. 
Da biste to uradili, otvorite okvir za dija-
log Equations, Global Variables, and Di-
mensions i pritisnite praznu ćeliju čvora 
Equations u koloni Name. U oblasti za cr-
tanje izaberite kotu s vrednošću 50; njeno 
ime će se prikazati u odgovarajućoj ćeliji 
kolone Name u okviru za dijalog. Zatim u 
oblasti za crtanje izaberite kotu s vredno-
šću 100. Pritisnite dugme sa zvezdicom (*) i u odgovarajuću ćeliju kolone Value / 
Equation upišite 0.5 (slika 19-7). Pritisnite zeleni znak za potvrdu. Nakon izračuna-
vanja jednačine, vrednost će se prikazati u koloni Evaluates to okvira za dijalog. Pri-
tisnite OK u tom okviru za dijalog; skica će se ponovo generisati, a vrednost kote za 
širinu pravougaonika izmeniće se u skladu s jednačinom koja je na nju primenje-
na. Pored toga, simbol jednačine biće dodat širini pravougaonika.

Kada dodate jednačine delu ili skici, na panou FeatureManager Design Tree 
automatski će se napraviti direktorijum Equations (slika 19-8). Više o tom direkto-
rijumu naučićete kasnije u ovom poglavlju.
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Slika 19-7  Okvir za dijalog Equations, Global Variables, and Dimensions nakon 
dodavanja jednačine

Napomena
Okvir za dijalog Equations, Global Variables, and Dimensions možete otvoriti i 
s panoa FeatureManager Design Tree. Da biste to uradili, desnim tasterom miša 
pritisnite direktorijum Equations na panou FeatureManager Design Tree i iza-
berite Manage Equations.

Menjanje jednačina

Direktorijum
Equations

Slika 19-8  Direktorijum 
Equations napravljen na panou 
FeatureManager Design Tree

Jednačine koje ste dodali projektu možete i 
menjati pomoću okvira za dijalog Equations, 
Global Variables, and Dimensions. Da biste 
to uradili, otvorite okvir za dijalog i u kolo-
ni Value / Equation pritisnite ćeliju s jednači-
nama koje ćete menjati; sadržaj ćelije postaće 
dostupan za menjanje pa možete da izmeni-
te jednačinu. Kada završite, pritisnite zeleni 
znak za potvrdu prikazan u ćeliji; unete iz-
mene će se odraziti na model u oblasti za cr-
tanje. Opcija Automatically rebuild mora da 
bude potvrđena u okviru za dijalog kako bi se 
primenjena jednačina automatski ažurirala.

Savet. Jednačine možete menjati i iz oblasti za crtanje. Da biste to uradi-
li, dvaput pritisnite kotu koja sadrži jednačine; prikazaće se okvir za dijalog 
Modify, s primenjenim jednačinama, pa ih možete izmeniti prema svojim po-
trebama.
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Brisanje jednačina
Nepotrebne jednačine možete obrisati iz okvira za dijalog Equations, Global Varia-
bles, and Dimensions. Da biste to uradili, otvorite taj okvir za dijalog i desnim ta-
sterom miša pritisnite jednačinu koju treba obrisati; prikazaće se priručni meni. U 
njemu izaberite opciju Delete Equation.

Izvoženje/uvoženje jednačina
U SOLIDWORKS-u možete izvoziti jednačine napravljene za jedan objekat i deli-
ti ih s drugim objektima. Da biste to uradili, pritisnite dugme Export u okviru za 
dijalog Equations, Global Variables, and Dimensions i snimite jednačine u tekstu-
alnu datoteku. Zatim otvorite drugi model i uvezite tekstualnu datoteku s jedna-
činama tako što ćete pritisnuti dugme Import. Međutim, preporučljivo je da pro-
menite ime mere na potpanou Primary Value panoa Dimension PropertyManager 
tako što ćete je izabrati. Slično izvoženju jednačina, možete ih i uvoziti pomoću 
dugmeta Import. 

Rad s konfiguracijama
U SOLIDWORKS-u možete lako napraviti više instanci jednog dela ili sklopa. Na 
primer, ako treba da napravite vijak i navrtku u raznim veličinama, ne morate pra-
viti delove različitih dimenzija, već samo napravite više konfiguracija. Postoje dve 
metode za pravljenje konfiguracija: ručno i pomoću projektne tabele. U nastavku 
je opisana metoda ručnog pravljenja konfiguracija, a druga metoda je objašnjena 
kasnije.

Ručno pravljenje konfiguracija

Slika 19-9  Model postolja mašine

Konfiguracije možete napraviti ručno i za-
dati njihova svojstva. Potom možete izme-
niti model ili sklop da biste napravili va-
rijacije u novoj konfiguraciji. Uzmimo za 
primer postolje mašine sa slike 19-9. Treba 
da napravite dve vrste projekta za isto po-
stolje. U prvom projektu vam treba kružno 
ležište na gornjoj stranici postolja, a u dru-
gom projektu kružno ležište treba da bude 
uklonjeno.

Da biste ručno napravili konfiguracije, 
pritisnite dugme ConfigurationManager pored dugmeta PropertyManager ispod 
CommandManagera. Primetićete da je model postolja mašine prikazan na slici 
19-9 sačuvan kao podrazumevana, Default, konfiguracija i da postaje aktivna. Čvor 
aktivne konfiguracije je žut.

Da biste napravili novu konfiguraciju, izaberite ime dela na panou Configurati-
onManager i pritisnite desni taster miša. Iz priručnog menija odaberite Add Confi-
guration, kao na slici 19-10. Kada izaberete tu opciju, otvoriće se Add Configurati-
on PropertyManager (slika 19-11). Na potpanou Configuration Properties, upišite 
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ime za konfiguraciju u polje Configuration name. Opis konfiguracije možete une-
ti u polje Description. U polje Comment možete uneti komentar o konfiguraciji.

Slika 19-10  Biranje opcije Add Configuration iz 
priručnog menija

Slika 19-11  Pano Add 
Configuration PropertyManager

Padajuća lista s potpanoa Bill of Materials Options koristi se za zadavanje ime-
na dela koje će biti prikazano u sastavnici kada se generiše tehnički crtež sa izabra-
nom konfiguracijom.

Kada proširite potpano Advanced Options, primetićete da je polje Suppress fea-
tures podrazumevano izabrano. Tada će novi tipski oblici i uslovi uklapanja koji su 
dodati u nekoj drugoj konfiguraciji istog dela biti automatski potisnuti u ovoj konfi-
guraciji. Potvrdite opciju Use configuration specific color da biste zadali boju za no-
vonapravljenu konfiguraciju. Kada potvrdite tu opciju, biće dostupno dugme Color. 
Pritisnite ga da biste otvorili istoimeni okvir za dijalog i zadajte boju za konfiguraciju.

Nova kon�guracija dodata na
pano Con�gurationManager

Slika 19-12  Nova konfiguracija prikazana 
na panou ConfigurationManager

Kada unesete sve podatke u Add Con-
figuration PropertyManager, pritisnite 
dugme OK; nova konfiguracija biće 
napravljena i automatski aktivirana. Njen 
čvor će na panou ConfigurationManager 
biti žut. Na slici 19-12 vidi se ime nove 
konfiguracije na panou Configuration-
Manager.
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Nakon što napravite konfiguraciju, izmenite tipske oblike modela koji treba 
da se prikažu u novonapravljenoj konfiguraciji. Za projekat postolja mašine tre-
ba ukloniti kružno udubljenje u drugoj konfiguraciji postolja. Znači, treba da po-
tisnete isečeni tipski oblik upotrebljen za izradu kružnog udubljenja na postolju. 
Da biste to uradili, aktivirajte FeatureManager Design Tree i potisnite isečeni tipski 
oblik. Kada budete hteli da se vratite na podrazumevanu konfiguraciju, na panou 
ConfigurationManager izaberite konfiguraciju Default i otvorite priručni meni. 
Odaberite opciju Show Configuration; prikazaće se konfiguracija Default i videće-
te da u njoj kružno udubljenje nije potisnuto. Alternativno, dvaput pritisnite kon-
figuraciju Default na panou ConfigurationManager da biste se vratili na nju. S dru-
ge strane, kada aktivirate novonapravljenu konfiguraciju, na postolju mašine neće 
se videti kružno udubljenje. Slika 19-13 prikazuje postolje mašine u konfiguraci-
ji Default, a slika 19-14 postolje mašine u konfiguraciji sa izmenjenim projektom.

Slika 19-13  Postolje mašine u konfiguraciji 
Default

Slika 19-14  Postolje mašine u konfiguraciji 
sa izmenjenim projektom

Menjanje tipskih oblika dela s više konfiguracija

Slika 19-15  Potpano 
Configurations

Kada izmenite tipske oblike dela s više konfiguracija, na 
panou PropertyManager za tipski oblik koji menjate biće 
prikazan potpano Configurations (slika 19-15). Konfigu-
raciju koju treba da menjate možete odabrati pomoću op-
cija s tog potpanoa. Sledi opis tih opcija.

This configuration
Kada izaberete radio-dugme This configuration, izme-
ne napravljene na tipskom obliku primeniće se samo 
na tekuću konfiguraciju. Isti tipski oblik neće se izme-
niti u ostalim konfiguracijama.

All configurations
Radio-dugme All configurations podrazumevano je izabrano, pa će se izmene 
napravljene na tipskom obliku primeniti na sve konfiguracije u tekućem doku-
mentu dela.
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Specify configurations
Izaberite radio-dugme Specify configurations da bi se izmene primenile samo na 
izabrane konfiguracije. Kada izaberete to radio-dugme, u polju sa listom biće na-
vedene sve konfiguracije u dokumentu dela. Tekuća konfiguracija je podrazume-
vano izabrana. Izaberite konfiguracije u kojima treba da se primeni izmena. Kada 
izaberete ovo radio-dugme, aktiviraće se dugmad All i Reset. Dugme All koristiće-
te da biste izabrali sve konfiguracije prikazane u polju sa listom.

Savet. 1. Konfiguraciju možete i prevući s panoa ConfigurationManager u 
dokument sklopa ili crteža. Kada postavite komponentu s više konfiguracija u 
dokument sklopa, ime tekuće konfiguracije prikazaće se uz ime dela na panou 
FeatureManager Design Tree.

2. Da biste promenili konfiguraciju komponenata postavljenih u dokument 
sklopa, izaberite komponentu i otvorite priručni meni. Iz priručnog menija 
odaberite Component Properties; otvoriće se istoimeni okvir za dijalog. U oblas-
ti Referenced configuration izaberite potrebnu konfiguraciju i pritisnite dugme 
OK. Alternativno, konfiguraciju možete izabrati iz padajuće liste prikazane 
iznad priručnog menija. Nakon što izaberete konfiguraciju, pritisnite zeleni 
znak za potvrdu prikazan desno od padajuće liste s konfiguracijama.

3. Konfiguraciju dela možete nezavisno menjati u svakom prikazu na tehnič-
kom crtežu. Da biste to uradili, izaberite prikaz, pritisnite ga desnim tasterom 
miša i iz priručnog menija odaberite Properties; otvoriće se okvir za dijalog 
Drawing View Properties. Promenite konfiguraciju tako što ćete izabrati dru-
gu opciju s padajuće liste Use named configuration.

Pravljenje konfiguracija pomoću projektnih tabela
Glavni meni:
Paleta alatki:

Insert > Tables > Design Table
Tools > Design Table

Ponekad treba da napravite deo koji će se više puta koristiti u projektovanju. 
Svaka instanca tog dela mogla bi imati istu geometriju, ali različite mere. Mo-

žete napraviti deo koji ima različite konfiguracije tako što ćete ručno izmeniti nje-
gove mere. Međutim, preporučuje se da tu vrstu konfiguracija pravite alatkom De-
sign Table. Da biste to uradili, pritisnite dugme Design Table na paleti alatki Tools 
ili odaberite Insert > Tables > Design Table iz glavnog menija; otvoriće se Design 
Table PropertyManager (slika 19-16).

U nastavku su opisani potpanoi panoa Design Table PropertyManager.

Potpano Source
Potpano Source koristi se za zadavanje vrste i izvora za umetanje projektne tabele 
u dokument dela ili sklopa. Sledi opis opcija s tog potpanoa.

Blank
Radio-dugme Blank koristi se za umetanje prazne projektne tabele. U praznu 
tabelu morate ručno da unosite parametre.
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Slika 19-16  Pano Design 
Table PropertyManager

Auto-create
Radio-dugme Auto-create podrazumevano je izabra-
no kada se otvori pano Design Table PropertyMa-
nager. Ono omogućava da umetnete novu projekt
nu tabelu u dokument dela ili sklopa. Ujedno će se 
učitati i svi parametri i odgovarajuće vrednosti u ta-
belu.

From file
Izaberite radio-dugme From file ako treba da umet-
nete postojeću projektnu tabelu. Projektne tabele 
se prave kao datoteke Microsoft Excela. Da biste po-
zvali sačuvanu tabelu, izaberite ovo radio-dugme i 
pritisnite dugme Browse na ovom potpanou; otvo-
riće se okvir za dijalog Open. Pronađite i otvorite 
datoteku koju ćete umetnuti kao projektnu tabelu; 
ime i putanja do izabrane datoteke prikazaće se u 
polju ispod radio-dugmeta. Polje za potvrdu Link to 
file dostupno je samo kada izaberete radio-dugme 
From file. Ako ga potvrdite, izmene napravljene u 
Excelovoj datoteci primeniće se na model dela ili 
sklop, i obrnuto.

Potpano Edit Control
Potpano Edit Control koristi se za zadavanje parameta-
ra dvosmernog upravljanja na projektnoj tabeli. Opci-
je s tog potpanoa objašnjene su u nastavku.

Allow model edits to update the design table
Ovo radio-dugme podrazumevano je izabrano, a ko-
risti se za dodavanje dvosmerne povezanosti između modela i projektne tabe-
le. Kada ga izaberete, izmene napravljene na modelu automatski će biti unete 
i u tabelu.

Block model edits that would update the design table
Ovo radio-dugme izabraćete da biste blokirali menjanje parametara modela 
koji bi bili ažurirani u projektnoj tabeli.

Potpano Options
Opcije s potpanoa Options koriste se za dodavanje redova ili kolona projektnoj ta-
beli i za upozorenja pre ažuriranja tabele, a njihov opis sledi.

New parameters
Opcija New parameters podrazumevano je potvrđena, a koristi se za automat-
sko dodavanje novih redova i kolona projektnoj tabeli kada novi parametri 
budu dodati tehničkom crtežu.
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New configurations
Opcija New configurations podrazumevano je potvrđena, a koristi se za auto-
matsko dodavanje novih kolona i redova projektnoj tabeli kada modelu bude 
dodata nova konfiguracija.

Warn when updating design table
Opcija Warn when updating design table podrazumevano je potvrđena i prika-
zuje poruku sa upozorenjem

Slika 19-17  Podloška zadatih dimenzija

 kad god se projektna tabela ažurira.

Razmotrite situaciju u kojoj treba da 
napravite podlošku sa spoljnim prečni-
kom 100 mm, unutrašnjim prečnikom 
50 mm i debljinom 10 mm, kao na sli-
ci 19-17. Pored toga, treba da napravite 
još pet podloški različitih mera. Pošto je 
geometrija podloške ista, a menjaju se 
samo mere, preporučuje se da napravi-
te jedan dokument dela podloške, a za-
tim da napravite različite konfiguracije 
podloške pomoću projektne tabele.

Kada napravite model dela, otvori-
te Design Table PropertyManager. Izaberite radio-dugme Auto-create i pritisni-
te dugme OK; biće napravljena projektna tabela s podrazumevanim parametrima. 
Alatke na paletama u SOLIDWORKS-ovom prozoru biće zamenjene alatkama Mi-
crosoft Excela. Pored toga, preko okvira za dijalog Creating design table prikazaće 
se okvir za dijalog Dimensions. Na slici 19-18 vidi se SOLIDWORKS-ov prozor na-
kon što je pritisnuto dugme OK na panou Design Table PropertyManager.

Slika 19-18  SOLIDWORKS-ov prozor tokom izrade projektne tabele
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Držite pritisnut taster CTRL i izaberite sve kote prikazane u okviru za dijalog 
Dimensions. Pritisnite dugme OK; imena izabranih kota s kotnim vrednostima za 
konfiguraciju Default prikazaće se na Excelovom radnom listu u oblasti za crtanje, 
kao na slici 19-19. Treba da zadate ime za drugu instancu modela koja će biti na-
pravljena i da unesete mere za tu instancu na Excelov radni list. Unesite imena i 
mere i za ostale instance, kao na slici 19-20.

Slika 19-19  Excelov radni list nakon biranja dimenzija u okviru za dijalog Dimensions

Kada zadate konfiguracije i mere na radnom listu Microsoft Excela, pritisnite 
bilo gde unutar oblasti za crtanje; prikazaće se poruka sa imenima konfiguracija 
koje je generisala projektna tabela. Pritisnite dugme OK u tom okviru.

Videćete da su na panou ConfigurationManager napravljene razne konfigura-
cije i da je konfiguracija Default [Washer] aktivna (slika 19-21). Ikonica Micro-
soft Excela, prikazana ispred čvora Design Table na panou ConfigurationMana-
ger, označava da je konfiguracija generisana pomoću projektne tabele. Ako treba 
da pogledate neku drugu konfiguraciju, izaberite je i pritisnite desni taster miša. Iz 
priručnog menija odaberite opciju Show Configuration. Drugi način je da dvaput 
pritisnete konfiguraciju na panou ConfigurationManager.

Napomena
U jednom dokumentu dela ili sklopa možete napraviti samo jednu projektnu tabelu.
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Slika 19-20  Excelov radni list nakon zadavanja 
imena novih instanci i dodavanja mera tim 

instancama

Slika 19-21  Pano Configuration 
Manager s različitim konfiguracijama

Menjanje stanja potisnutosti pomoću projektne tabele

Slika 19-22  Završena ploča

Stanje potisnutosti za tipske oblike 
komponente možete menjati pomoću 
projektne tabele. Ova metoda je veoma 
korisna u projektnim biroima jer može-
te generisati različite konfiguracije dela 
s dodatim tipskim oblicima koji će biti 
napravljeni nakon svake faze proizvod-
nog procesa. Pretpostavimo da imate 
zalihe pravougaonih poluga i hoćete da 
napravite ploču sa slike 19-22.

Da biste ploču napravili od metalne 
poluge, prvo glodalicom uklonite mate-
rijal iz njene unutrašnjosti. Potom izbušite rupe u ležištu i na gornjoj stranici plo-
če. Nakon svih tih operacija, zarubite gornje ivice ploče.

Da biste sve te faze prikazali na CAD delu u SOLIDWORKS-u, u tabeli napra-
vite različite konfiguracije u kojima će se prikazati svaka faza proizvodnog proce-
sa. Konfiguracije možete napraviti i ručno, ali bi vam to oduzelo mnogo vremena.

Pre nego što napravite navedene vrste konfiguracija, treba da promenite ime tip-
skog oblika na panou FeatureManager Design Tree. Da biste promenili ime tipskog 
oblika, izaberite ga, a potom još jednom pritisnite levim tasterom miša; njegovo ime 
će se prikazati u polju za unos. Upišite novo ime za tipski oblik. To nije obavezno 
već se radi samo da bi se izbegle zabune. Snimite model i otvorite Design Table 
PropertyManager, pritisnite radio-dugme Auto-create i dugme OK; otvoriće se okvir 
za dijalog Dimensions. Ne birajući mere iz tog okvira za dijalog, pritisnite OK; prika-
zaće se projektna tabela samo sa imenom tabele. Dvaput pritisnite sve tipske oblike 
prikazane na panou FeatureManager Design Tree. Imena tipskih oblika prikazaće se 
u gornjem redu, a odgovarajuća stanja potisnutosti biće prikazana ispod imena tip-
skih oblika u Microsoft Excelu (slika 19-23).
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Slika 19-23  Excelov radni list nakon dodavanja tipskih oblika u projektnu tabelu

Svi tipski oblici su prikazani u nepotisnutom stanju. U ćeliju A3 upišite ime 
konfiguracije Finished Plate (gotova ploča). U ćeliju A4 upišite ime druge konfi-
guracije, Billet Stock (poluga). Sada za sve tipske oblike u projektnoj tabeli, osim 
osnovnog tipskog oblika, zadajte potisnuto stanje. Umesto da pišete celu reč, mo-
žete upisati S za potisnuto stanje, a U za nepotisnuto. U ćeliju A5 upišite ime tre-
će konfiguracije, Pocket Milling (glodanje ležišta) i potisnite sve tipske oblike osim 
osnovnog tipskog oblika, ležišta i zaobljenih tipskih oblika. Napravite i ostale kon-
figuracije. Slika 19-24 prikazuje projektnu tabelu nakon zadavanja svih konfigura-
cija i odgovarajućih stanja potisnutosti.

Slika 19-24  Projektna tabela nakon zadavanja svih konfiguracija i odgovarajućih  
stanja potisnutosti
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Pritisnite bilo gde unutar oblasti za crtanje i pritisnite dugme OK u okviru s 
porukom da biste se vratili u okruženje za modelovanje delova. Slike od 19-25 do 
19‑29 prikazuju različite konfiguracije ploče napravljene tako što su u projektnoj 
tabeli izmenjena stanja potisnutosti za tipske oblike.

Slika 19-25  Ploča prikazana  
u konfiguraciji Billet Stock

Slika 19-26  Ploča prikazana  
u konfiguraciji Pocket Milling

Slika 19-27  Ploča prikazana  
u konfiguraciji Dia 5 Holes

Slika 19-28  Ploča prikazana  
u konfiguraciji Dia 6 Holes

Slika 19-29  Ploča prikazana u konfiguraciji Chamfer

Menjanje projektne tabele
Projektnu tabelu napravljenu u dokumentu dela ili sklopa možete menjati. Da biste 
to uradili, raširite čvor Tables, pa desnim tasterom miša pritisnite ikonicu Design 
Table na panou ConfigurationManager; otvoriće se priručni meni. Iz priručnog 
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menija odaberite opciju Edit Table; otvoriće se okvir za dijalog Add Rows and Colu-
mns. Ukoliko su konfiguracije ili parametri dodati modelu nakon izrade projektne 
tabele, te konfiguracije i parametri biće navedeni u odeljcima Configurations odno-
sno Parameters okvira za dijalog Add Rows and Columns. Prikazane parametre i 
konfiguracije možete odabrati i dodati projektnoj tabeli, a zatim pritisnuti dugme 
OK u okviru za dijalog; okruženje za modelovanje delova biće zamenjeno Excelovim 
okruženjem, a u oblasti za crtanje prikazaće se radni list. Izmenite list pa pritisnite 
bilo gde unutar oblasti za crtanje da biste se vratili u SOLIDWORKS-ovo okruženje 
za modelovanje delova.

Svojstva projektne tabele možete menjati i tako što ćete otvoriti Design Table 
PropertyManager. Da biste to uradili, pritisnite ikonicu Design Table na panou 
ConfigurationManager i otvorite priručni meni. Iz priručnog menija odaberite op-
ciju Edit Feature; otvoriće se Design Table PropertyManager i moći ćete da izme-
nite svojstva projektne tabele.

Savet. 1. Projektnu tabelu možete menjati i u zasebnom Excelovom prozoru. 
Da biste to uradili, pritisnite desnim tasterom miša ikonicu Design Table na 
panou ConfigurationManager i iz priručnog menija odaberite opciju Edit Ta-
ble in New Window; otvoriće se zaseban Excelov prozor. Kada izmenite pro-
jektnu tabelu, zatvorite Excelovu datoteku; projektna tabela će se ažurirati u 
SOLIDWORKS-u.

2. Projektnu tabelu napravljenu u dokumentu dela ili sklopa možete sačuvati. 
Da biste to uradili, desnim tasterom miša pritisnite ikonicu Design Table na 
panou ConfigurationManager i iz priručnog menija odaberite opciju Save Ta-
ble; prikazaće se Excelov radni list. Ako ste menjali model nakon izrade projekt
ne tabele, otvoriće se okvir za dijalog Save As. Unesite ime i izaberite lokaciju 
gde ćete snimiti projektnu tabelu.

Brisanje projektne tabele
Projektnu tabelu koja vam ne treba u dokumentu dela ili sklopa možete ukloni-
ti. Da biste to uradili, izaberite ikonicu Design Table na panou ConfigurationMa-
nager i pritisnite taster DELETE; prikazaće se okvir s porukom Confirm Delete u 
kome ćete izabrati odgovarajuću opciju. Čak i ako obrišete projektnu tabelu, kon-
figuracije koje ste pomoću nje napravili neće biti obrisane.

Menjanje stanja potisnutosti komponente bez otvaranja 
projektne tabele
U prethodnom odeljku naučili ste kako da menjate stanje potisnutosti raznih tip-
skih oblika komponente pomoću projektne tabele. Međutim, stanje potisnutosti 
tipskog oblika možete menjati i bez otvaranja projektne tabele.

Da biste izmenili stanje potisnutosti tipskih oblika, izaberite sve tipske oblike na 
panou FeatureManager Design Tree i otvorite priručni meni. Iz priručnog menija 
odaberite opciju Configure Feature; otvoriće se prozor Modify Configurations sa 
imenima izabranih tipskih oblika navedenim u kolonama (slika 19-30).
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Slika 19-30  Prozor Modify Configurations

Levim tasterom miša pritisnite jednom unutar ćelije <Creates a new configurati-
on.>, upišite ime nove konfiguracije i pritisnite jednom unutar bilo koje ćelije; za 
novu konfiguraciju biće napravljen nov red s poljima za potvrdu. Napravite i osta-
le konfiguracije. Zatim, da biste potisnuli određeni tipski oblik u nekoj konfigura-
ciji, potvrdite odgovarajuću opciju, kao na slici 19-31. Možete promeniti i dimen-
zije tipskog oblika. Obratite pažnju na to da se ovaj termin odnosi na dimenzije 
unete u PropertyManager dok ste pravili tipski oblik, a ne na mere na skici. Da bi-
ste promenili dimenzije tipskog oblika, pritisnite strelicu nadole na naslovnoj traci 
kolone; prikazaće se potpaleta sa imenom. Izaberite polje za potvrdu koje se nala-
zi pored imena; dimenzija će biti navedena u prozoru Modify Configurations, kao 
na slici 19-32. Ukoliko je potrebno, u tom prozoru možete promeniti mere tipskog 
oblika. Pritisnite dugme OK; konfiguracije će biti napravljene i prikazane na pa-
nou ConfigurationManager.

Slika 19-31  Prozor Modify Configurations nakon zadavanja tipskih oblika koji će biti 
potisnuti u raznim konfiguracijama

Ukoliko treba da promenite ime konfiguracije ili da je obrišete, izaberite je i 
pritisnite desni taster miša kako biste otvorili priručni meni. Iz priručnog menija 
odaberite odgovarajuću opciju da biste promenili ime konfiguracije ili je obrisali.

Kad hoćete da izmenite konfiguraciju, izaberite tipske oblike i otvorite prozor 
Modify Configurations. Potvrdite polje ili uklonite potvrdu iz polja da biste izme-
nili konfiguraciju, pa pritisnite OK.
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Slika 19-32  Prozor Modify Configurations nakon zadavanja mera tipskih oblika

Menjanje vidljivosti komponenata u raznim 
konfiguracijama sklopa
I u režimu Assembly možete menjati vidljivost komponenata u različitim konfigu-
racijama. Otvorite ConfigurationManager i desnim tasterom miša pritisnite unutar 
oblasti Display States. Iz priručnog menija odaberite opciju Add Display State; biće 
dodato novo stanje prikaza. Na isti način dodajte proizvoljan broj stanja prikaza. 
Oblast Display States nakon što su dodata nova stanja, prikazana je na slici 19-33.

Kad menjate boju, teksturu ili stanje prikaza, dvaput pritisnite stanje prikaza da 
biste ga aktivirali. Zatim otvorite FeatureManager Design Tree i pritisnite simbol 
strelice da bi se otvorilo okno za prikaz. Promenite boju, stanje prikaza ili provid-
nost dela u sklopu. Slično tome, aktivirajte ostala stanja prikaza i promenite odgo-
varajuće boje ili providnost. Slika 19-34 prikazuje okno za prikaz u kome su različi-
tim delovima sklopa promenjene boje, providnost i način prikaza.

Ime aktivnog
stanja prikaza

Boja primenjena
na nivou komponente

Boja primenjena
na nivou dela

Režim prikaza
žičanog modela

Uključena providnost

Slika 19-33  Pano Display States 	
nakon dodavanja novih stanja

Slika 19-34  Pano FeatureManager Design Tree  
sa oknom za prikaz

Da biste videli razna stanja prikaza, dvaput pritisnite odgovarajuće stanje prika-
za u oblasti Display States panoa ConfigurationManager. Drugi način je da otvo-
rite paletu alatki Display States i odaberete odgovarajuće stanje s padajuće liste.
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Tipski oblici iz biblioteke
U većini projekata postoje tipski oblici koji se često koriste. Takve tipske oblike mo-
žete napraviti i sačuvati u biblioteci kako biste ih mogli koristiti kad god vam za-
trebaju za neki deo sklopa. Time se ubrzava izrada istog dela ili tipskog oblika. U 
ovom odeljku saznaćete kako da napravite tipski oblik za biblioteku, postavite ga u 
deo, menjate i razlažete.

Pravljenje tipskog oblika za biblioteku

Slika 19-35  Pano Add to 
Library PropertyManager

Tipski oblik za biblioteku (engl. library feature) pravi 
se tako što se snimi postojeći tipski oblik s drugom 
oznakom tipa datoteke. Da biste tipski oblik sačuvali u 
biblioteci, prvo morate napraviti osnovni tipski oblik, 
a zatim jedan ili više tipskih oblika koji će biti dodati 
u biblioteku. Kada ih napravite, izaberite tipske obli-
ke koji će biti dodati u biblioteku i snimite ih sa ozna-
kom tipa .sldlfp.

Razmotrite primer u kom izvučeni tipski oblik i za
obljeni tipski oblik treba da budu sačuvani u biblio-
teci. Treba da napravite osnovni tipski oblik, zatim 
izvučeni tipski oblik i na kraju da dodate zaobljenja 
izvučenom tipskom obliku. Kada napravite model, iza-
berite njegovo ime na panou FeatureManager Design 
Tree i otvorite priručni meni. Iz njega izaberite op-
ciju Add to Library; otvoriće se pano Add to Library 
PropertyManager (slika 19-35). Primetićete da je ime 
modela podrazumevano prikazano u polju selekcije 
na potpanou Items to Add. Poništite tekuću selekci-
ju, pa na panou FeatureManager Design Tree izabe-
rite tipske oblike koji će biti dodati biblioteci. Izvuče-
ni tipski oblik i tipski oblik zaobljenja modela (slika 
19‑36) izabrani su kao tipski oblici za biblioteku.

U polje File name na potpanou Save To upišite 
ime tipskog oblika za biblioteku. Potom izaberite lo-
kaciju za snimanje tipskog oblika tako što ćete proširi-
ti čvorove u polju Design Library folder.

S padajuće liste File type na potpanou Options, 
odaberite opciju Lib Feat Part (*.sldlfp), ako nije već 
izabrana. Ukoliko hoćete da unesete kratak opis tip-
skog oblika, upišite ga u polje Description na potpa-
nou Options.

Pritisnite dugme OK kada zadate sve parametre; tipski oblici će biti sačuvani u 
biblioteci. Takvi tipski oblici će na ikonicama imati znak L, a uz ime dokumenta 
dela na panou FeatureManager Design Tree biće prikazan znak biblioteke (slika 
19-37). Otvorite okno poslova Design Library i pronađite mesto na koje ste snimi-
li tipski oblik za biblioteku pa ga možete pogledati.
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Izvučeni tipski oblik 
koji će biti dodat iz biblioteke

Tipski oblik zaobljenja 
koji će biti dodat iz biblioteke

Osnovni
tipski
oblik

Slika 19-36  Tipski oblici koji će biti dodati iz biblioteke

Ikonica tipskog
oblika iz biblioteke

Tipski oblici dodati
kao tipski oblici

iz biblioteke

Slika 19-37  Ikonica biblioteke i znak L prikazan na ikonicama tipskih oblika

Napomena
Ako je tipski oblik za biblioteku bio postavljen u odnosu na neki objekat u tipskom 
obliku u kom je napravljen, prilikom postavljanja tipskog oblika iz biblioteke mora
te zadati i referencu.

Postavljanje tipskih oblika iz biblioteke u deo
Nakon izrade i snimanja tipskih oblika za biblioteku, možete ih postaviti u doku-
ment dela. Da biste to uradili, otvorite okno poslova Design Library tako što ćete 
pritisnuti istoimeno dugme i pronaći mesto gde ste snimili tipski oblik za biblio-
teku. Potom prevucite tipski oblik i spustite ga na stranicu modela; otvoriće se od-
govarajući PropertyManager (slika 19-38). Ukoliko treba da promenite ravan za 
postavljanje tipskog oblika iz biblioteke, uklonite postojeću ravan postavljanja na 
potpanou Placement Plane panoa Library Feature PropertyManager i izaberite 
drugu. Kad izabrani tipski oblik iz biblioteke ima više konfiguracija, to će biti pri-
kazano na potpanou Configurations.
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Slika 19-38  Dokument dela s panoom Library Feature PropertyManager

Kad izaberete tipski oblik iz biblioteke napravljen s referencama, videćete nje-
gov prikaz u prozoru. Pored toga, program će tražiti da zadate reference. Ako pri-
tisnete unutar prozora za prikaz, otvoriće se paleta View (Heads-Up) i moći ćete 
da pregledate tipski oblik pomoću alatki s te palete. Zadajte reference u oblasti za 
crtanje; prozor za prikaz će nestati, a položaj tipskog oblika u odnosu na izabra-
ne reference prikazaće se u oblasti Locating Dimensions panoa Library Feature 
PropertyManager.

Ako izabrani tipski oblik iz biblioteke nema reference, otvoriće se potpano Lo-
cation. Pritisnite dugme Edit Sketch na tom potpanou i navedite lokaciju tipskog 
oblika.

Slika 19-39  Tipski oblik iz biblioteke 
postavljen na gornju stranicu modela

Ukoliko hoćete da izmenite tekuće mere tipskog oblika iz biblioteke, potvrdi-
te opciju Override dimension values na potpanou Size Dimensions i promenite 
vrednosti. Izmenjen tipski oblik prikazaće 
se pod imenom Custom configuration na 
potpanou Configuration.

Kada na potpanou Configuration po-
tvrdite opciju Link to library part, refe-
rence do tipskog oblika iz biblioteke saču-
vaće se u delu. Ukoliko promenite tipski 
oblik iz biblioteke, izmena će se odraziti i 
na model.

Slika 19-39 prikazuje tipski oblik iz bi-
blioteke postavljen na gornju stranicu 
modela.

Menjanje tipskih oblika iz biblioteke
Tipske oblike koji su uključeni u dokument dela za tipski oblik iz biblioteke mo-
žete menjati. Tipski oblik koji hoćete da uklonite izaberite u oknu poslova Design 
Library. Otvorite priručni meni i iz njega odaberite opciju Delete. Ukoliko treba 
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da izmenite tipski oblik iz biblioteke, izaberite ga u oknu poslova Design Library i 
otvorite priručni meni, pa iz njega odaberite opciju Open. Otvoriće se dokument 
dela za tipski oblik iz biblioteke. Izmenite tipski oblik i snimite ga. Ako ste na pot-
panou Configuration potvrdili opciju Link to library part kada ste postavljali tipski 
oblik iz biblioteke, izmena koju na njemu napravite primeniće se i na dokument u 
koji ste umetnuli tipski oblik iz biblioteke.

Razlaganje tipskih oblika iz biblioteke
Ako postavite tipski oblik iz biblioteke, ispred imena tipskog oblika prikazaće se 
ikonica biblioteke, a ako pokušate da ga izmenite, otvoriće se Library Feature 
PropertyManager. Da biste tipski oblik iz biblioteke pretvorili u pojedinačan tipski 
oblik dela, morate ga razložiti. To ćete učiniti tako što ćete tipski oblik iz bibliote-
ke odabrati na panou FeatureManager Design Tree i otvoriti priručni meni, pa iz 
njega odabrati opciju Dissolve Library Feature. Tipski oblik iz biblioteke razložiće 
se na pojedinačne tipske oblike.

Vežbe

Vežba 1
U ovoj vežbi otvorićete skicu napravljenu u vežbi 3 iz poglavlja 2. Skici dodajte 
mere prema slici 19-40 i izvucite skicu do dubine 50 mm. Potom dodajte jednači-
ne da biste je kotirali. Kota s vrednošću 150 biće upravljačka kota. Dok dodajete 
jednačine, možete promeniti vrednosti vertikalnih kota 20 i 40 u vrednosti 25 i 50 
radi lakšeg izračunavanja.

(Očekivano vreme: 30 min)

Slika 19-40  Skica za vežbu 1
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Da biste završili ovu vežbu, pratite sledeće korake:

a.	 Otvorite nov dokument dela i vežbu 3 iz poglavlja 2.
b.	 Izvucite skicu na dubinu 50 mm.
c.	 Izmenite kote i dodajte jednačine alatkom Equations.
d.	 Snimite model.

Otvaranje novog dokumenta i izvlačenje tipskog oblika
1.	 Otvorite nov SOLIDWORKS-ov dokument i otvorite vežbu 3 iz poglavlja 2.
2.	 Dodajte relacije i kotirajte skicu da biste je potpuno definisali, prema slici 19-40.
3.	 Izvucite skicu na dubinu 50 mm.
4.	 Pritisnite dugme Save As i snimite model pod imenom p19_vezba1.

Dodavanje jednačina kotama skice
Na ovom modelu horizontalna kota s vrednošću 150 treba da bude upravljač-
ka, a ostale kote treba da budu izvedene. Pored toga, promenićete vrednosti 
vertikalnih kota u 25 i 50 radi lakšeg izračunavanja.

1.	 Aktivirajte okruženje za skiciranje i izmenite skicu osnovnog tipskog oblika, 
dvaput pritisnite vertikalne kote i promenite vrednost 20 u 25, a vrednost 40 
u 50.

2.	 Pritisnite dugme Equations na paleti Tools; otvoriće se okvir za dijalog Equa-
tions, Global Variables, and Dimensions.

3.	 Pritisnite praznu ćeliju pod čvorom Global Variables u koloni Name i upi
šite Length kao ime globalne promenljive, prema slici 19-41. Zatim pritisnite 
odgovarajuću praznu ćeliju u koloni Value / Equation i u oblasti za crtanje iza
berite kotu s vrednošću 150. Upišite komentar za dodatu globalnu promen
ljivu u odgovarajuću ćeliju kolone Comments.

4.	 Pritisnite praznu ćeliju pod čvorom Equations u koloni Name.
5.	 U oblasti za crtanje izaberite poluprečnik s vrednošću 30; u izabranoj ćeliji pri-

kazaće se izabrana kota.
6.	 U oblasti za crtanje izaberite horizontalnu kotu s vrednošću 150; u koloni Val-

ue / Equation prikazaće se ime izabrane kote i zeleni znak za potvrdu.
7.	 Pritisnite taster kose crte ( / ) i unesite vrednost 5; jednačina će postati “D6@

Sketch1” = “D8@Sketch1” / 5, gde je D6@Sketch1 = 30 a D8@Sketch1 = 150. 
Imena kota mogu biti drugačija pošto se ona zasnivaju na sekvenci u kojoj su 
mere primenjene na skicu.

8.	 Pritisnite odgovarajuću ćeliju u koloni Comments; u koloni Evaluates to prika-
zuje se vrednost 30 mm, a pojavljuje se i nova prazna ćelija pod čvorom Equa-
tions. Sada morate uneti Radius u odgovarajuću ćeliju kolone Comments.
Imajte u vidu da globalne promenljive možete koristiti i dok dodajete jed-
načine.

9.	 Slično opisanom, pritisnite praznu ćeliju čvora Equation u koloni Name i u 
oblasti za crtanje izaberite vrednost prečnika 30; ime izabrane kote prikazaće 
se u koloni Name.
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10.	 U oblasti za crtanje izaberite horizontalnu kotu s vrednošću 150; u koloni Val-
ue / Equation prikazaće se ime izabrane kote i zeleni znak za potvrdu. 

11.	 Pritisnite taster kose crte ( / ) i unesite vrednost 5; jednačina će postati “D7@
Sketch1” = “D8@Sketch1” / 5, gde je D7@Sketch1 = 30 a D8@Sketch1 = 150. 
Imena kota mogu biti drugačija pošto se ona zasnivaju na sekvenci u kojoj su 
mere primenjene na skicu.

12.	 Pritisnite odgovarajuću ćeliju u koloni Comments; u koloni Evaluates to pri-
kazuje se vrednost 30 mm. Sada morate uneti Diameter u odgovarajuću ćeli-
ju kolone Comments. 

13.	 Na isti način dodajte jednačine za sve kote, kao što je ovde navedeno:

Izabrana kota Jednačina koja se dodaje Komentar

Vertikalna kota 25 150/6 Height (visina)

50 150/3 Hole Location (položaj rupe)

35 150/30*7 Slot Location (položaj proreza)

Horizontalna kota 25 150/6 Slot (prorez)

5 150/30 Slot depth (dubina proreza)

14.	 Promenite veličinu okvira za dijalog Equations, Global Variables, and Dimen-
sions. Nakon dodavanja svih jednačina, on će izgledati kao na slici 19-41.

Slika 19-41  Okvir za dijalog Equations, Global Variables, and Dimensions nakon 
dodavanja svih jednačina

15.	 Pritisnite dugme OK u okviru za dijalog Equations, Global Variables, and Di-
mensions; mere će na skici biti prikazane sa znakom jednakosti. Pored toga, 
panou FeatureManager Design Tree biće dodat direktorijum Equations. Iza-
đite iz okruženja za skiciranje.
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Dodavanje jednačine izvučenom tipskom obliku
Treba da dodate jednačinu izvučenom tipskom obliku tako da njegovim di-
menzijama upravlja horizontalna kota s vrednošću 150.

1.	 Desnim tasterom miša pritisnite direktorijum Equations na panou FeatureMa-
nager Design Tree; prikazuje se priručni meni. U njemu izaberite opciju Man-
age Equations; prikazuje se okvir za dijalog Equations, Global Variables, and 
Dimensions.

2.	 Dvaput pritisnite model u oblasti za crtanje; prikazaće se mere skice i tipskog 
oblika.

3.	 Pritisnite praznu ćeliju čvora Equations u koloni Name i izaberite kotnu vred-
nost 50 – kotu izvučenog tipskog oblika.

4.	 U oblasti za crtanje izaberite vrednost horizontalne kote 150. Potom pritisnite 
prvo kosu crtu, a zatim unesite vrednost 3 u ćeliju koja odgovara toj kotnoj 
vrednosti u čvoru Equation, prema slici 19-42.

5.	 Pritisnite odgovarajuću ćeliju kolone Comments i upišite Extrude (izvlačenje).
6.	 Pritisnite dugme OK da biste izašli iz okvira za dijalog.

Slika 19-42  Okvir za dijalog Equations, Global Variables, and Dimensions nakon 
dodavanja jednačine izvučenom tipskom obliku

Menjanje mera modela
1.	 Pritisnite model; prikazaće se sve mere.
2.	 Pritisnite kotnu vrednost 150 i u polje upišite 300.
3.	 Ponovo izgradite model; sve mere modela biće izmenjene.

Napomena
Za potrebe ove vežbe, sve dimenzije su zaokružene. Međutim, tipskom obliku/koti 
možete dodati bilo koju matematičku relaciju, s tim što projekat ne sme biti narušen.

4.	 Snimite model.
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Vežba 2
U ovoj vežbi napravićete inbus vijak prikazan na slici 19-43. Otprilike procenite 
prečnik osnove vijka – d – na primer, 30 mm. Modelu dodajte jednačine, kao što je 
prikazano na slici 19-44. Potom napravite različite konfiguracije za menjanje preč-
nika osnove u 20 mm, 50 mm, 40 mm i 5 mm, i za menjanje drugih povezanih pa-
rametara u skladu s relacijama na slici 19-44.

(Očekivano vreme. 30 min)

Slika 19-43  Inbus vijak Slika 19-44  Parametri inbus vijka

Da biste završili ovu vežbu, pratite sledeće korake:

a.	 Napravite inbus vijak alatkama Revolved Boss/Base i Extruded Cut.
b.	 Napravite različite konfiguracije pomoću projektne tabele.
c.	 Snimite model.

Izrada inbus vijka
1.	 Otvorite nov SOLIDWORKS-ov dokument i nacrtajte skicu osnovnog tipskog 

oblika. Osnovni tipski oblik je napravljen tako što je skica rotirana za 360º. 
Nemojte praviti zaobljenja niti obarati ivice.

2.	 Kotirajte skicu na osnovu relacija datih na slici 19-44. Dok postavljate kote, 
morate im menjati imena na potpanou Primary Value panoa Dimension Prop-
ertyManager. Imena dodelite prema slici 19-45.

3.	 Napravite osnovni tipski oblik alatkom Revolved Boss/Base.
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Slika 19-45  Imena 
mera

4.	 Nacrtajte šestougao na gornjoj površini osnovnog tip
skog oblika i kotirajte ga. Promenite ime mere prema 
slici 19-45.

5.	 Alatkom Extruded Cut napravite šestougaoni usek u os-
novnom tipskom obliku.

6.	 Dodajte zaobljenja i oborene ivice (zarubljenja).
7.	 Snimite model pod imenom p19_vezba2 u direktorijum 

za poglavlje 19.

Pravljenje konfiguracija pomoću projektne tabele
Sada treba da napravite inbus vijke istog oblika a različi-
tih veličina, pomoću alatke Design Table.

1.	 Iz glavnog menija odaberite Insert > Table > Design Ta-
ble; otvoriće se Design Table PropertyManager.

2.	 Izaberite radio-dugme Auto-create na potpanou Source. 
Pobrinite se da radio-dugme Allow model edits to up-
date design table bude izabrano, a sve opcije s panoa De-
sign Table PropertyManager potvrđene.

Slika 19-46  Projektna tabela  
s podrazumevanim merama

3.	 Pritisnite dugme OK na panou Design Table Property-
Manager; otvoriće se okvir za dijalog Dimensions.

4.	 Pritisnite taster CTRL, pa izaberite imena svih kota sa liste u okviru za dijalog 
Dimensions, osim D1@Revolve1, D1@Fillet1, D1@Chamfer1 i D2@Cham-
fer1. To su imena za kote obrtnog tipskog oblika, tipskog oblika zaobljenja 
odnosno tipskih oblika zarubljenja.

5.	 Pritisnite dugme OK u okviru za di-
jalog Dimensions; prikazaće se pro-
jektna tabela s podrazumevanim 
merama, kao na slici 19-46.

6.	 Novim instancama dajte imena 
20x60, 50x150, 40x120 i 5x15 tako 
što ćete ih upisati u ćelije A4, A5, 
A6 odnosno A7.

Napomena
Ako slučajno pritisnete unutar 
oblasti za crtanje, projektna ta-
bela će nestati. Da biste je pono-
vo prikazali, otvorite Configura-
tionManager, desnim tasterom 
miša pritisnite čvor Design Table 
i iz priručnog menija odaberite op-
ciju Edit Table.
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7.	 Unesite mere za nove instance u skladu s jednačinama prikazanim na slici 
19‑44. Excelov radni list će nakon dodavanja mera izgledati kao na slici 19-47.

Slika 19-47  Nove instance i njihove mere

8.	 U ćeliji A3, ime Default promenite u 30x90.
9.	 Pritisnite bilo gde unutar oblasti za crtanje; otvoriće se okvir sa imenima 

napravljenih konfiguracija.
10.	 Pritisnite OK u okviru za dijalog.
11.	 U okviru za dijalog Equations, dodajte jednačine merama za zaobljenje i zaru-

bljenje, prema slici 19-44.
12.	 Otvorite ConfigurationManager; na njemu će biti navedene napravljene kon-

figuracije. Dvaput pritisnite konfiguraciju da biste je aktivirali.
13.	 Snimite model.

Test za samostalnu proveru znanja
Odgovorite na sledeća pitanja i zatim uporedite svoje odgovore sa onima datim na 
kraju poglavlja.

1.	 Alatkom Equations možete zadavati matematičke relacije između mera mo
dela ili mera skice. (Da/Ne)

2.	 Jednačine dodate projektu pomoću okvira za dijalog Equations, Global Vari-
ables, and Dimensions mogu se menjati. (Da/Ne)

3.	 Jednačine koje vam ne trebaju u određenoj fazi rada možete potisnuti.  
(Da/Ne)

4.	 Kad primenjujete konfiguracije, možete napraviti više instanci dela ili sklopa u 
jednom SOLIDWORKS-ovom dokumentu. (Da/Ne)
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5.	 Stanje potisnutosti tipskog oblika komponente možete menjati pomoću pro-
jektne tabele. (Da/Ne)

6.	 Tipski oblik konfiguracije ne možete potisnuti bez projektne tabele.
7.	 Koji se PropertyManager koristi za izradu projektne tabele?

(a) Design Table (b) Create Design Table
(c) Physical Dynamics (d) Nijedan od navedenih

8.	 Radio-dugme  podrazumevano je izabrano kada otvorite Design 
Table PropertyManager.

9.	 Da biste razložili tipski oblik biblioteke, odaberite opciju  iz 
priručnog menija. 

10.	 Tipski oblici koji će biti dodati kao tipski oblici biblioteke čuvaju se s nastav-
kom imena .

Pitanja
Odgovorite na sledeća pitanja:

1.	 Ako pokušate da izmenite tipski oblik biblioteke, otvoriće se Library Feature 
PropertyManager. (Da/Ne)

2.	 Tipski oblik za biblioteku možete da postavite samo u prazan dokument dela 
nakon što ste u tipski oblik za biblioteku uključili osnovni tipski oblik. (Da/Ne)

3.	 Šta od sledećeg treba da otvorite kako biste promenili boju, teksturu i stanje 
prikaza konfiguracije?

	 (a) Okno Display na panou FeatureManager
	 (b) Okno Display na panou PropertyManager
	 (c) Okno Display na panou ConfigurationManager
	 (d) Ništa od navedenog

4.	 Konfiguraciju možete pogledati na panou ConfigurationManager čak i ako ni-
jednom nije otvorena niti snimljena. (Da/Ne)

5.	 Možete napraviti samo jednu projektnu tabelu u dokumentu dela ili sklopa. 
(Da/Ne)

6.	 Morate potisnuti jednačinu kako biste mogli da menjate odgovarajuće izve-
dene kote. (Da/Ne)

7.	 Okvir za dijalog Equations, Global Variables, and Dimensions možete otvo
riti tako što ćete upotrebiti čvor Equations na panou FeatureManager Design 
Tree. (Da/Ne)

8.	 Ako je položaj tipskog oblika biblioteke zadat u odnosu na objekat iz tipskog 
oblika u kom je tipski oblik biblioteke napravljen, morate zadati referencu pri-
likom postavljanja tipskog oblika biblioteke. (Da/Ne)

9.	 Vidljivost komponenata možete promeniti u različitim konfiguracijama.  
(Da/Ne)

10.	 Konfiguracije možete prevlačiti s panoa Configuration Manager u dokument 
sklopa ili crteža. (Da/Ne)
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Zadaci

Zadatak 1
Napravite model sa slike 19-48. Mere modela su date na slici 19-49. Izvucite skicu 
naviše do dubine 20 mm. Potom dodajte jednačine kotama skice i tipskog oblika. 
Kota s vrednošću 80 treba da bude upravljačka kota. Dok dodajete jednačine, pro-
menite kotne vrednosti 30 i 15 u 40 i 20 radi lakšeg izračunavanja. 

(Očekivano vreme: 30 min)

Slika 19-48  Pun model za zadatak 1 Slika 19-49  Mere modela za zadatak 1

Zadatak 2
Nacrtajte skicu modela sa slike 19-50. Skica koju treba nacrtati prikazana je na slici 
19-51. Izvucite skicu na dubinu od 20 mm. Dodajte jednačine merama skice i tip-
skom obliku. 

(Očekivano vreme: 30 min)

Slika 19-50  Pun model za zadatak 2 Slika 19-51  Skica za zadatak 2
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Zadatak 3
Napravite vijak s valjkastom glavom prikazan na slici 19-52. Neka prečnik osnove 
vijka, d, bude 25 mm. Napravite model s relacijama datim na slici 19-53. Potom na-
pravite različite konfiguracije tako što ćete menjati prečnik osnove na 20 mm, 15 
mm, 12 mm i 6 mm. Zadajte ostale parametre u skladu s relacijama datim na sli-
ci 19-53. 

(Očekivano vreme: 30 min)

Slika 19-52  Vijak s valjkastom glavom Slika 19-53  Parametri vijka s valjkastom 
glavom

Rešenja testa za samostalnu proveru znanja
1. Da, 2. Da, 3. Da, 4. Da, 5. Da, 6. Ne, 7. a, 8. Auto-create, 9. Dissolve Library Fea
ture, 10. .sldlfp


